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CWS/CMS Court Guide

HEARINGS

SCHEDULING THE FIRST HEARING 

(Only do this if there are no hearings entered in CWS/CMS, or if you want to separate siblings from hearings)
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	Create the first hearing using the plus (+) button under the icon.  

Complete the ID page with scheduling information.

Complete the MINORS page with the type of hearing scheduled and including all appropriate siblings.

SAVE TO DATABASE


SCHEDULING ALL SUBSEQUENT HEARINGS  

(Use this command if there is a recent hearing already in CWS/CMS- Don’t use this if all the minor’s from the previous hearing aren’t to be carried over to the future hearing.)
	[image: image90.emf]
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	Open ‘Existing Hearing’ and select the most recent hearing.



	ACTION/ CREATE NEXT HEARING
	Under ACTION, use the Create Next Hearing command.
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	Complete the ID page with scheduling information.

Complete the MINORS page with the type of hearing scheduled and including all appropriate siblings.

SAVE TO DATABASE 


CONTINUING A HEARING
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	Open the hearing that you want to record as continued.
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	On the RESULTS page, select all appropriate minors, and click on the ‘Continued’ radio button.
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	On the ID page, record the date the hearing was continued to, and select the reason for the continuance.



	ACTION / CREATE CONTINUED HEARING


	Under ACTION, use the ‘Create Continued Hearing’ command to create the new hearing.

SAVE TO DATABASE




REMOVING A HEARING 
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	Open the hearing that you want to remove.
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	Adjust the hearing date to a future date. 

Hearings with past dates can never be removed. 
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	Use the ‘Open Existing Hearing’ command to access the dialog box with the list of hearings:  

Highlight the hearing adjusted to the future date.

Click the REMOVE button.
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If this warning message appears, you need to REMOVE the court report or petition that is associated with the Hearing you are trying to remove.
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	Open the ‘existing court document’ notebook, and select the court report or petition with the same date as the hearing you are trying to remove.

Use the REMOVE button to delete the report. 

Open the ‘existing petition’, and remove any petition notebook associated with the hearing.

Use the REMOVE button to delete the petition notebook. 

Open the ‘existing court report’ and remove any court report notebook associated with the hearing.

Use the REMOVE button to delete the court report notebook. 

NOTE:  If you don’t want to delete the Court Document permanently – Open the Report, use the SAVE AS function to save it outside of CWS/CMS before you remove it. Then you can paste it back in later. 
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	Use the ‘Open Existing Hearing’ command to access the dialog box with the list of hearings:  

Highlight the hearing adjusted to the future date.

Click the REMOVE button.

Once Court Documents have been deleted from the hearing, it can be removed.

SAVE TO DATABASE




Things to Check before Beginning A Court Report

	
CLIENT INFO



    


Be sure there is a Client Notebook for all family members involved in case.  If there are missing clients, search the database, and attach them or create them as necessary.

Each client’s notebook should be reviewed for accuracy.


	[image: image22.bmp]
· Gender, DOB, Age, SSN entered.

· Confidentiality in effect if this child is in placement.

· ICWA eligibility checked if applicable.

· Indian ancestry checked if applicable.

· Primary Language and Ethnicity entered.

[image: image23.bmp]
· If the court limits the right of a parent/guardian to make education decisions for a child, check box on this page.

[image: image24.bmp]
· Check this page for each parent to make sure the correct addresses have been entered.  Be sure that STOP dates have been entered for invalid addresses.

[image: image25.bmp]
· Make sure relationships are correct. Pay close attention to the status of fathers. 

[image: image26.bmp]
· Juvenile Court number should be entered for all case focus children if case status is ‘Court’. Be sure it is active. 

[image: image27.bmp]
· Be sure that attorneys representing clients have been recorded.  The start and end dates must correspond with when attorneys were appointed and dismissed.  If incorrect dates used, they will populate to reports incorrectly.



	
COLLATERALS
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	When a child is initially removed from his home, relatives that may be considered as possible substitute care providers need to be entered into the application as a Client or a Collateral.

SAVE TO DATABASE – before beginning the Court Report.


PETITIONS

CREATING A NEW PETITION
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	Open the ‘Existing Hearing’ that you are preparing the petition for.  If the hearing has not been entered into the system, use the plus button under the Hearing Notebook to create the hearing.  Complete the ID and the Minors page.

At the bottom of the ID page of the hearing – use the Plus button – Create New Petition to begin setting the parameters for the petition.  



	You Will Now Be in the Petition Notebook:
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[image: image35.bmp]
[image: image36.png]



	Record status of Petition on the ID page.

On the Minors page, select all 300 WIC subdivisions that apply for each child.

On the ID page, you will find the plus button at the bottom of the screen to “Create New Petition Document”.   Select JV110 if filing a joint dependency petition for children with same mother and father.  Select JV100 if filing a separate petition for each child.

This will create the Petition document shell in Word.
SAVE TO DATABASE
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	All Court documents that have been created in CWS/CMS will be filed here.  They can be retrieved, viewed, modified, and printed at any time.




UPDATING PETITION -  FILED DATE AND STATUS

	Open the Existing Petition:
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                                 [image: image39.bmp]

	Once the Petition is filed, the filed date and time can be entered on the ID page.

The Petition status can be updated as appropriate to: Dismissed, Sustained, etc.

SAVE TO DATABASE


AMENDING A PETITION

	Open the Existing Petition:

[image: image40.png]
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	If a Petition has been filed, and is in Pending status: 

Use the Create Amended Petition under the Action menu to amend the Petition.  

This creates a new Petition notebook and the amended Petition document can be generated using the + sign on the bottom of the ID page.

The original petition’s status is automatically entered as ‘superseded’

SAVE TO DATABASE


CREATING COURT REPORTS & DOCUMENTS
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	Open the ‘Existing Hearing’ that you are preparing a court report for.

At the bottom of the ID page of the hearing – use the Plus button – Create New Court Report Notebook to select the type of report you want to create.



	You Will Now Be in the Court Report Notebook:
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	On the ID page, select the type of court report you want to create.

Be sure to select all children the court report is for.

At the bottom of the ID page of the Court Report Notebook, use the Plus button – “Create New Court Report Document” to create the actual Court Report Document.

SAVE TO DATABASE
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	All Court documents created in CWS/CMS will be filed here. They can be retrieved, viewed, modified, and printed at any time.


Creating a Court Report when No Hearing is Scheduled 

(ex. ExParte for Judge’s Signature only )

	Create ‘New Hearing’


[image: image50.wmf]    
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                [image: image52.bmp]

	Create ‘New Hearing’.

On the ID page – choose “Date Not Set”.

12/31/2099 will automatically populate.

At the bottom of the ID page of the hearing – use the Plus button – Create New Court Report to select the type of report you want to create.



	You Will Now Be in the Court Report Notebook:

[image: image53.bmp]
SAVE TO DATABASE
	Select the type of court report you want to create, ex. Exparte Application and Order.

Be sure to select all children the court report is for.

At the bottom of the ID page of the Court Report Notebook, use the Plus button – “Create New Court Report Document” to create the actual Court Report Document shell.
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	All Court Report documents that have been created in CWS/CMS will be filed here.  

They can be retrieved, viewed, modified, and printed at any time.

	“Open the Existing Hearing”:
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	Open the Existing Hearing and select the 12/31/2099 hearing. 

Change the date – to the date the Judge signed the order.   

Notes section – narrate the circumstances here.

IMPORTANT:  A case cannot be closed with 12/31/2099 hearings.


PREPARING NOTICES AND PROOF OF SERVICE DOCUMENTS
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	Open the ‘Existing Hearing’ that you are preparing notices for.

On the NOTICES page, use the plus (+) button in the left corner to activate the screen.  

Select the type of notice you are preparing, all intended recipients, service method & date of service for each.



	FILE

PRINT REPORT
	In the Areas of Interest – be sure that Court Reports is selected, then choose the type of Notice you are preparing.

Make sure the appropriate hearing is highlighted, and complete each dialog box with applicable information.

Notices are not saved, but can be re-created and printed at any time under File, Print Report.  


CREATING A COURT CALENDAR

	FROM THE CONTROL PANEL – CLICK ON CASELOAD

[image: image59.bmp]                       
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	Under the ‘Area of Interest’, be sure that Caseload Reports is selected.  Then select ‘Caseload Court Calendar Report’, and Print.

Select the Caseload you want to print the calendar for.

Specify the date range and how the report should be sorted.


APPOINTING AN ATTORNEY TO A CLIENT
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	Select the client you want to attach an attorney to.
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	Complete an ‘Attorney Search’.

Searching with only ‘county’ selected, will bring the entire list of attorney’s in the County. If there are too many hits, add additional search criteria, ie., a city.
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	On ATTORNEYS page, use the plus (+) in left corner to begin, select client’s attorney and start date.


DISMISSING AN ATTORNEY
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	Select the client you want to record the dismissal of their attorney.
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	On ATTORNEYS page, enter an ‘end date’ to document date attorney was dismissed.

SAVE TO DATABASE


UPDATING ADDRESSES FOR CLIENTS
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	To update/change an address for a client – you need to open that individual’s client notebook and complete the address page.  

Addresses that are not current, must be end dated!

SAVE TO DATABASE


RECORD PARENT SEARCH RESULTS 

Open the Case for the child whose Parent Search was completed.

	Once the Case is open:

Open the ‘Existing Client Notebook’:



           



	Select the Parent that the search was completed on. 
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SAVE TO DATABASE
	Use this page to log any searches you have performed on behalf of a client.

Results of a search can be recorded at any time.  

Add appropriate information in the Description and Results fields.  




If results of parent search are recorded in this manner, they will automatically populate the Declaration of Due Diligence.

CREATE A DECLARATION OF DUE DILIGENCE

Open the Case for the child whose Parent Search was completed.

	Open the Existing Hearing:
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	Open the ‘existing hearing’ that the Declaration is being prepared for.

Use the ‘plus button’ on the ID page to create the Court Report.

Under the drop down menu for Report Type – Select the ‘Declaration of Due Diligence’.  

Be sure to select all children the report is being created for.

Under Search Efforts for:   Select the parent that you are generating the Declaration for.
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SAVE TO DATABASE
	Use the ‘Create New – Court Report’ button to begin generating the report in Word.

This document can be modified, added to, and spell checked.  

Save – Print – Close.




Once the Declaration is filed in Court, you will need to record the filing date.

Recording the Filing Date:

	
Open the Existing Court Report Notebook:



                          [image: image76.bmp]
SAVE TO DATABASE
	Select the ‘Declaration of Due Diligence’ from the list.

Record the ‘Filed Date’ on the ID page.


RECORDING HEARING RESULTS AND ATTENDEES
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	Open the hearing that you want to record the findings and orders for:

On the results page, select all children to record results for, select the appropriate radio button, then enter findings and orders.

Use detail description at the bottom of the page to describe any findings and orders more completely.
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	Use the attendees page, to record all persons attending the hearing.

SAVE TO DATABASE




CREATING A HEARING SUMMARY
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	Open the hearing that you want to prepare a summary for.  You will be on the ID page. 

Be sure that the hearing results and attendees pages have been completed if you are creating a ‘post hearing’ summary.
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	Use the Create New – Hearing Summary Document on the bottom of the ID page.

Court Summary will produce the document.




REMINDERS IN COURT – AND HOW TO SATISFY THEM

15 Day Detention Report Due

This reminder is generated when all the following conditions exist:

· The Hearing Type is "15 Day Review" (Hearing notebook, Minors page).

· There is no Continuance Reason (Hearing notebook, ID page).

· No Court Report notebook with a Report Type of "15 Day Detention Review" is attached to the Hearing notebook.

The reminder Due Date equals the Hearing Date (Hearing notebook, ID page). 

To satisfy the reminder, create a Court Report notebook for the minor named in the Hearing notebook with a Report Type of "15 Day Detention Review" and attach it to the Hearing notebook.

Court Report Due

This reminder is generated when all the following conditions exist:

· There is no Continuance Reason (Hearing notebook, ID page).

· The Hearing Type is "364," "366.21(e)," "366.21(f)," "366.22," "366.25," "366.26," or "366.3" (Hearing notebook, Minors page).

· No approved Court Report notebook for the Minor is associated to the Hearing notebook.

The reminder Due Date is equal to the Hearing Date (Hearing notebook, ID page) minus 10 calendar days.

To satisfy the reminder, create a Court Report notebook for the Minor and attach it to the Hearing notebook.

Declaration of Due Diligence for 366.25 or 366.26 Due

This reminder is generated when all the following conditions exist:

· The Hearing Type is "366.25" or "366.26."

· There is no Continuance Reason (Hearing notebook, ID page).

· A minor calendared for the hearing has an absent parent (Client notebook, Related Clients page, Parents Whereabouts Unknown selected).

· There is no Court Report notebook with a Report Type of "Declaration of Due Diligence" for the parent associated with this Hearing notebook.

The reminder Due Date is equal to the Hearing Date (Hearing notebook, ID page) minus 75 calendar days.

To satisfy the reminder, create a Court Report notebook with a Report Type of "Declaration of Due Diligence" for the absent parent and attach it to the Hearing notebook.

Review Hearing Notice Due

This reminder is generated when all the following conditions exist:

· The Hearing Type "364," "366.21(e)," "366.21(f)," "366.22," "366.25," or "366.3" (Hearing notebook, Minors page).

· There is no Continuance Reason (Hearing notebook, ID page).

· There is no Date of Service for any notice (Hearing notebook, Notices page).

The reminder Due Date is equal to the Hearing Date minus 17 calendar days (Hearing notebook, ID page).

To satisfy the reminder, enter a Date of Service for at least one notice.

Selection of Permanent Plan Notice Due

This reminder is generated when all the following conditions exist:

· The Hearing Type is "366.26" (Hearing notebook, Minors page).

· There is no Date of Service for any notice (Hearing notebook, Notices page).

The reminder Due Date is equal to the Hearing Date minus 55 calendar days (Hearing notebook, ID page).

To satisfy the reminder, enter a Date of Service for at least one notice.

MAPPING for the Legal History Section of Court Reports

INITIAL DETENTION ORDER  -  DETENTION HEARING

· Detention Ordered – Out of Home

· Detention Ordered – In Home

· Detained from Parents/Legal Guardians

· Detained from Father

· Detained from Mother

· Detained in the Home or non-Custodial Parent

INITIAL JURISDICTION FINDING – JURISIDICTION HEARING

· Child Described by Section 300

INITIAL DISPOSITION ORDER  -  DISPOSITION HEARING

· Dependency Declared

INITIAL 364 FM REVIEW

· Will automatically enter the date if this type of hearing is present.

2ND 364 FM REVIEW

· Worker must enter.

366.21 (e)  6 MO REVIEW

· Will automatically enter the date if this type of hearing is present.

366.21 (f) 12 MO REVIEW

· Will automatically enter the date if this type of hearing is present.

366.22 18 MO/PERMANENCY

· Will automatically enter the date if this type of hearing is present.

FR SERVICES TERMINATED

· Court Order of ‘FR Services Terminated’ needs to be entered.

NON REUNIFICATION ORDERED

· Court Order of ‘361.5 FR Services Not Ordered’ must be entered.

INITIAL PERMANENT PLAN:  TYPE/DATE ORDERED

· PP Ordered – Adoption  -  Description will be ‘Adoption’

· PP Ordered – Legal Guardianship  -  Description will be ‘Guardianship’

· PP Ordered – LTFC Initial  -  Description will be ‘LTFC’

· PP Ordered – LTFC Continued – Description will be ‘LTFC’

· Guardianship Established – 360 (a)  -  Description will be ‘Guardianship’

· Guardianship Established – 366.26  -  Description will be ‘Guardianship’

CWS/CMS COURT MANAGEMENT REPORTS

PMCRPTIM    Court Report Timeliness Report
This report presents data on the timeliness of status review and 366.26 WIC assessment court reports. Totals and percentages are based upon a file date 10 days prior to the hearing date.

· From the Caseload File menu select Print Report. The Print Report dialog box opens. In the Area of Interest, select "Program Management - Court," then select "Court Report Timeliness Report."

This report is generated monthly and provides information at county, region, office, unit, and caseload levels.

PMCRTCAL   Court Calendar Report
· This report is sorted by Staff Person, Hearing Date, Hearing Time, Hearing Type, and Court Department.

1. From the Caseload File menu select Print Report. The Print Report dialog box opens.

2. In the Area of Interest, select "Program Management - Court," then select        PMCRTCAL Court Calendar Report".

3. Click Print. The PMCRTCAL Court Calendar Report dialog box opens.

4. The minimum data that can be entered is the Period [week] End Date, County (which    defaults to logged-on user’s county), Region and Office.  The Unit and Caseload are   optional entries.

5. Click OK to print the report.

· In place of the name of any child marked Sensitive or Sealed in the CWS/CMS database, the word “Suppressed” will print. The remainder of the child’s data will print normally in the report.

· This report is generated weekly, and each weekly extract will contain the current month’s calendar plus two months in the future.

PMCTCONT   Court Continuance Report
This report presents the number of court continuances, grouped by reason for the continuance.

· From the Caseload File menu select Print Report. The Print Report dialog box opens. In the Area of Interest, select "Program Management - Court," then select "Court Continuance Report."

This report is generated monthly and provides information at state, county, region, office, and caseload levels.

PMHRGOUT   Hearing Outcome Report
This report presents, for each petition type, the number of hearings filed, the number and type of hearings held, the number dismissed, sustained, and pending at the end of the reporting period, the number of detentions or placements ordered, and the number of declarations of dependency.

· From the Caseload File menu select Print Report. The Print Report dialog box opens. In the Area of Interest, select "Program Management - Court," then select "Hearing Outcome Report."

This report is generated monthly and provides information at the county level.

PMPETDSP   300 Petition Filing To Disposition Time
This report lists the number of days between the filing of a 300 petition to declaration of dependency.

· From the Caseload File menu select Print Report. The Print Report dialog box opens. In the Area of Interest, select "Program Management - Court," then select "300 Petition Filing to Disposition Time."

This report is generated monthly and provides information at the county, region, office, unit, and caseload levels.

WORD TIPS

Court Report Construction

All court reports are generated in Times New Roman/12 font style/size. All have standard margins of 1” on the top and 1.2” on the left, and ½” on the right and bottom of the reports. The pleading numbers are built into the page 2 through last headers on the side. The reports are not ‘write protected’ in any way. Like any WORD document, the text fields expand as much as is needed. Sections or data may be deleted or inserted in any location, including pre-populated grids. For further detail regarding the construction and formatting of these documents, please refer to the format2.doc.

Text fields are identified by gray squares or boxes. These are non-protected form fields and a user may navigate from form field to form field simply by hitting the F11 function key. It is recommended that the tab keys NOT be used to navigate. The mouse may also be used by inserting the cursor into the form field. However, if the cursor is just before or just after the form field, problems may result.

Users may also use the cursor to add, delete or modify any section or specific data in a court report document: for example deleting a parent's address and inserting Confidential. Then hit F11 and the cursor will automatically take you to the next form field. As soon as the first character is entered in the form field, the gray box disappears.

The headers for pages two through last displays only one child’s name, usually the oldest. If there is more than one child included  in the report, the words, “et al.’ Are displayed after the child’s name. If you wish to modify these headers to add the names of the other children, it can be done. However, if your county has selected numbered lines for your court reports, modifying the headers may cause the loss of the numbered lines. To avoid this problem, you may wish to not modify the headers. However, if you do wish to modify headers, go to View in the Menu bar and then select Header and Footer. A new tool bar will display so you can modify the header or footer.

Hidden Text

To view court report templates with the hidden text displayed, then make sure the ‘Show/Hide’ control is on ‘Show.’ This control is usually located in your menu bar and resembles a paragraph icon. Or you may select ‘Tools’ in the Menu Bar, and then select ‘Options.’ Then select ‘View’ and make sure ‘Hidden’ and ‘All’ are checked. To view these reports without the hidden text, follow the same process but make sure ‘Hidden’ and ‘All’ are not checked. 

Much hidden text is included in the court report templates at present. This was intended to give direction to users about what type of information is to be included in specific sections of these reports. Some of this direction is based on statutory or regulatory requirements; other direction is based on standard casework practice. This hidden text is also included in the training guides.

To print out a hard copy of a report: While the report is displayed on the screen, go to File on the Menu bar, and select Print; when the dialog box displays, select Options. In the Options section, if you wish the hidden text to print make sure there is a check in the hidden text check box; if you do not want the hidden text to print, make sure there is no check in the hidden text check box. Also, if your county has numbered lines in the court reports, and you need them to show on the printed report, be sure you keep the check in the checkbox for Drawing Objects! Once the numbers are gone they cannot be retrieved for a specific document. So the important thing is if you need them, don’t lose them!

View Options

To view your document you have several options. First you may wish to reduce the viewing size from 100% to 75% by making a selection from your zoom section in the menu bar or by selecting Zoom from the View menu. 

You may work on your document in either Normal or Page Layout mode. Both options are available in the View menu in the menu bar. The page layout option is especially helpful to determine whether a page break is needed before the signature section, for example. [See page break section below.] Or for other formatting decisions in finalizing the document before it is printed.

Page Breaks

No page breaks are included in the new design. However, returns creating empty rows or page breaks may be inserted as needed to ensure the data is displayed appropriately. If your court requires the signature sections to be on a page with at least one line of text from the body of the report (such as the recommendation section), then you may need to insert a page break to accommodate this. To do so, place your cursor where you want the page break to be inserted. Then go to Insert in the Menu bar and select Page Break, Next Page, then click OK. If the page break is inadvertently placed in the wrong location, simply highlight it with your cursor shaped like an arrow in the left margin and hit the delete button.

Copy and Paste

This is one of the most commonly used WORD commands in creating documents. It is a huge time saver but there are some tricks that can save you grief. For example, if you are copying and pasting a selection from another document, even a court report, it is best to highlight the selection and then format it for the new report first. So, while it is selected or highlighted, go up to the menu bar and make sure the font style is Times New Roman and make sure the font size is 12. You may also want to make sure the margins of the document you are taking the selection from does not have right and left hand margins smaller than those described above. Finally, if your county uses single space text, you may need to make sure the text is ‘at least 12.2’ before pasting. [This is the standard used in court report documents for ‘single spaced’ text.] If your county uses double space text, you may need to make sure the text is ‘at least 24.45’ before pasting. [This is the standard used in court report documents for ‘double spaced’ text.] 

Once you have the selected text formatted the way you want it for the new document, then select or highlight it, press the control key and the letter C at the same time to copy; then put your cursor in the new document where you want the selected text pasted, press the control key and the letter V at the same time. The selected text should now be displayed in your new document. You may prefer to use the copy (the two pages) and paste (the little clipboard) commands in the Menu Bar; or even the copy and paste commands listed in the Edit Menu from the Menu Bar. It doesn’t matter which command options you prefer, they all get the job done!

Now many of you will decide you don’t need to follow the above instructions. So when you copy and paste and the selection in your new report is all ‘kiddy-wampus’ as they say, all is not lost. The first thing to try is to select or highlight the pasted selection and then go to the menu bar and select the correct font style and size as indicated above. Same as to single vs. double space. You can fix it after the fact, it is just a bit more challenging.

Undo

This is one of the most important commands to know. No matter what you do, you can always hit the ‘undo’ control and make your ‘boo boo’ go away!! The undo button is located in the Menu bar and looks like a rounded arrow pointing to the left. This even works when you don’t know what you did such as hitting a key by mistake that does something weird. Or, easier yet, if a dialog box suddenly appears on the screen and you don’t know how it got there, simply click away from the box and it will disappear.

Font Style/Size Changes

Times New Roman and Arial have been the two most common font styles used in dependency court documents in California. The majority of the 58 counties voted for their preference and Times New Roman was the font style selected. Size 12 was selected as being either required or the most readable for most of the courts. However, if your court insists on a different font style or size, you may follow these steps: 

1. Generate a court report and display it on the screen.

2. Press down the control key at the same time as the A key. This will select the entire document which will appear black.

3. Using your mouse, go up to the font style area on the menu bar and select Arial (or whatever font style is desired).

4. Move the mouse into the body of the document and click. The black will disappear and the report will now be displayed in Arial font.

5. Repeat these steps to return the court report to Times New Roman font style.

Follow the same steps to modify the font size, if you wish to use size 11, for example. 

Anytime you modify the font style or size, you run the risk of disrupting the original formatting. So if you do this, you will need to review the modified report very carefully. Also, modifications to the headers and footers need to be done separately. 

Delete and Insert -- Text

None of the Court Reports are write protected. That means you can modify them as needed. For example, if you wish to use the Detention Report template for a Non Detained/Initial Petition Hearing, you may delete the word Detention from the Title section and Insert Non Detained or Initial Petition or Arraignment or whatever meets your local needs and practice. 

The same is true of entire sections in a report that are generally needed in your county but for a particular situation are not. You always have the option of entering Not Applicable or Does Not Apply to a particular section; alternatively (and this will save space, resulting in a shorter report), you may wish to simply delete an entire section. To delete, select or highlight a word, or a section with your cursor and hit your delete key. If you have inadvertently deleted too much, click on the undo control in your menu bar, and then try again!

Sometimes an additional section might be needed for a report. You may always insert something ( a word, a paragraph a section, etc) wherever you put your cursor. Just start typing or you may wish to copy and paste. 

To insert an extra section, the best thing to do is to select/highlight a section in the court report that is similar to what you want to add. For example, your county does not generally use Family Law Status and did not opt to have that section in its reports. But you have a gnarly case that came to juvenile court after several years of Family Law litigation and multiple reports of child abuse with both parents being the alleged perpetrators over the years. You may wish to add a Family Law Status section. Select or highlight the Criminal History section including the title and the text field, for example, then copy it. The place your cursor where you want the Family Law Status section to appear in the report, and then paste the selection into your report. Now delete the section title of Criminal History and insert the title you wish, in this instance it would be Family Law Status. You do not need to worry about the hidden text since it should not appear when you print your report, though you can delete it if you wish.

Delete and Insert – Tables

Deleting tables is a bit different from deleting straight text:

If you wish to delete one or more rows in a table, highlight the rows; then go up to the Table menu in the Menu Bar and hit Delete Rows, and the highlighted rows, as well as any text within the highlighted rows, will be deleted.

If you wish to delete only the text in a table but not the table or any rows themselves, highlight the row(s) and hit the delete key; only the text within the highlighted table or rows will be deleted.

[For super users: If you wish to delete a combination of table rows and text outside of the table, you may highlight all of the table as well as the text outside of the table, or selected rows within the table and text outside of the table, then hit the delete key and all will be deleted.]

Inserting rows in a table can be done in either of two ways:

If you wish to add rows at the end of a table, simply hit the tab key and a row will be added (you may need to tab through the columns in the table before the new row will be added.]

If you wish to insert a row in the middle of a table, highlight the row below the place where you wish the table added. Then go up to the Table menu in the Menu Bar and hit Insert Row. The new row will be inserted just above the row you originally highlighted.

Identifying an Indian Child in CWS/CMS

	OPEN CHILD’S CLIENT NOTEBOOK 


                   



	Open the child’s Client Notebook that you are identifying as an Indian child.

	



	Indian Ancestry – if child is a descendent of an Indian, check this box. 

Use the +plus sign to record the date county was informed of Indian Ancestry in the grid below this indicator.

Primary Ethnicity or Other Ethnicity – if the child’s ethnicity is American Indian, record it here.

ICWA Eligibility – if the child is or may be an Indian child, record the appropriate ICWA status.
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	This page will be populated with information entered on this child’s parents ICWA page.  

Membership status information for child can be entered here once parent information entered.

	
	

	OPEN PARENT’S CLIENT NOTEBOOK
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If the child is an adopted child…record this information in the child’s client notebook.

SAVE TO DATABASE      
	Open the Parent’s Client Notebook that you want to record Tribal Membership information for.
Use the plus + sign to activate the page.

Tribal Membership section:

Choose:  Location

               Tribe

               Tribal Organization

Ancestor Section:

Choose:  Relative type and record as much information about that relative as possible.

You can choose mother, father and grandparents.

Information recorded on this page will populate to the child’s ICWA page.


ICWA

ICWA-030 can be automatically generated from the Notices Page in the 

Hearing Notebook.

Notices Page:  When the notice type ‘Indian Child Proceeding’ is selected, this box will appear on page:


This box will allow worker to choose who the data for the 

ICWA-030 is based on. 


If the client notebook contains

children with adoptive relationship

as well as birth children, this dialog

box will appear -  ICWA-030 must be 

generated separately for each. 


If Birth children selected,

then select parents from

this box.

The ICWA-030 document is based on ‘full’ siblings – therefore the parents selected in this dialog will determine which children and tribes appear in the following box.  The tribes populate from the ICWA page of the client notebooks. 

Select children and tribes

from this dialog.

Once the Document Data Based on box has been completed, choose recipients

of the notice in the usual way:


Then use the + Create Document to produce the ICWA-030.  

This is the first dialog to appear – select the petitioner here.
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The next dialog will appear so that former addresses of parents can be selected.  This information will populate to the ICWA-030.


Paternity: at least             

one check box

needs to be checked

or all three unknown

checked.

Make the 

appropriate 

selections from the

rest of this dialog box.

This box will only appear if YES was selected to any of the questions in 

center section of the previous dialog box. [image: image88.png]1CWA 1v-135 Ad
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This box will appear with any grandparents listed from the ICWA page of the client notebooks.  Any grandparent selected will populate to the ICWA-030.
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Worker will be able to select addresses for each recipient as usual .

Once the document is produced – the worker has capability of ‘unprotecting’ it in order to edit as necessary.  

From TOOLS menu – select ‘Unprotect Document’.  Edit document, and save.  

The ICWA-030 is a saved document – it is stored in the same place as court reports.  
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